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Note

This document and other information from Parker-Hannifin Corpora-
tion, its subsidiaries and authorized distributors provide product or 
system options for further investigation by users having technical 
expertise. 
The user, through its own analysis and testing, is solely responsible for 
making the final selection of the system and components and assuring 
that all performance, endurance, maintenance, safety and warning 
requirements of the application are met. The user must analyze all 
aspects of the application, follow applicable industry standards, and 
follow the information concerning the product in the current product 
catalog and in any other materials provided from Parker or its subsidi-
aries or authorized distributors. 
To the extent that Parker or its subsidiaries or authorized distributors 
provide component or system options based upon data or specifica-
tions provided by the user, the user is responsible for determining that 
such data and specifications are suitable and sufficient for all applica-
tions and reasonably foreseeable uses of the components or systems.
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1.3.	 Name plate

1.4.	 Block diagram

1.	 Introduction
1.1.	 Front view / dimensions

1.2.	 Ordering code

Position 
control 

universal

Electronic 
module for 
DC valves

Design 
series

Amplifier,
Min/Max adjustment, 
accel/decel ramps,

command input

Technology 
function

Code Function
0 Standard
1 Linearization

PWD XX A 40
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1.6.	 Technical data

Parker electronic modules PWDXXA-40X for rail 
mounting are compact, easy to install and provide 
time-saving wiring by disconnectable terminals. 
The digital design of the circuit results in good 
accuracy and optimal adaption for proportional 
directional control valves with position sensor by 
a comfortable interface program.

1.5.	 Characteristics

The described electronic unit combines all neces-
sary functions for the optimal operation of pro-
portional directional control valves with position 
sensor. The most important features are:
•	 digital circuit design
•	 parametrizable control as position control for 

valve spool or external closed loop control

General
Model Module package for snap-on mounting on EN 50022 rail
Package material Polycarbonate
Inflammability class V2..V0 acc. UL 94
Installation position Any
Ambient temperature range [°C] -20...+60
Protection class IP 20 acc. EN 60529
Weight [g] 160
Electrical
Duty ratio [%] 100
Supply voltage [VDC] 18...30, ripple < 5% eff., surge free
Switch-on current typ. [A] 22 for 0.2 mS
Current consumption max. [A] 2.0
Pre-fusing [A] 2.5 A medium lag
Command signal options   

                                                                      

[V]
[mA]
[mA]

  
  

+10...0...-10, ripple < 0.01 % eff., surge free, Ri = 100 kOhm
+20...0...-20, ripple < 0.01 % eff., surge free, Ri = 200 Ohm
4...12...20, ripple < 0.01 % eff., surge free, Ri = 200 Ohm
< 3.6 mA = solenoid output off, 
> 3.8 mA = solenoid output on (acc. NAMUR NE43)

Input signal resolution [%] 0.025
Differential input voltage max. [V] 30 for terminals 5 und 6 against PE (terminal 8)
Enable signal [V] 0...1: Off / 3...30: On / Ri = 100 kOhm
Status signal [V] 0...0.5: Off / Us: On / rated max. 15 mA
Monitor signal [V] +10...0...-10, rated max. 5 mA, signal resolution 0.4 %
Adjustment ranges  � Min

Max
Ramp

Zero offset
Current 

Initial current

[%]
[%]
[s]

[%]
[A]
[%]

0...50
50...100
0...32.5
+100...-100
1.3 / 2.7 / 3.5
0...25

Interface RS 232C, DSub 9p. male for null modem cable
EMC EN 61000-6-2, EN 61000-6-4
Connection Screw terminals 0.2...2.5 mm², disconnectable
Cable specification [AWG]

[AWG]
16 overall braid shield for supply voltage and solenoids
20 overall braid shield for sensor and signal

Cable length [m] 50
Options
Technology function Code1 Software adjustable transfer function with 10 compensation points 

for linearization of valve behaviour.

•	 constant current control
•	 differential input stage with different signal options
•	 monitor output for spool stroke/feedback, status 

output
•	 four quadrant ramp function
•	 enable input for solenoid driver
•	 status indicator
•	 parametering by serial interface RS-232
•	 connection by disconnectable terminals
•	 compatible to the relevant European EMC-

standards
•	 comfortable interface program
•	 optional technology function "linearization"
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1.7.	 Signal flow diagram
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3.2.	 Common instructions

We reserve the right of technical modifications of 
the described product. Illustrations and drawings 
within this manual are simplified representations. 
Due to further development, improvement and 
modification of the product, the illustrations might 
not match precisely with the described valve. The 
technical specifications and dimensions are not 
binding. No claim may resulting from it. Copyrights 
reserved.

3.3.	 Liability

The manufacturer does not assume liability for 
damage due to the following failures:
•	 incorrect mounting / installation
•	 improper handling
•	 lack of maintenance
•	 operation outside the specifications
•	

	Do not disassemble the electronics! In case 
of suspicion for a defect please return the unit 
to the factory.

3.4.	 Storage

In case of temporary storage the electronics must 
be protected against contamination, atmospheric 
exposure and mechanical damages.

2.	 Safety instructions

Please read the operation manual before installa-
tion, startup, service, repair or stocking! Paying no 
attention may result in damaging the electronics or 
incorporated system parts.

2.1.	 Symbols

This manual uses symbols which have to be fol-
lowed accordingly:

	 Instructions with regard to the warranty

	 Instructions with regard to possible dam-
aging of the electronics or linked system 
components

	 Helpful additional instructions

2.2.	 Marking, name plates

Instructions applied on the electronics, i.e. wiring 
diagrams and name plates, must be observed and 
maintained legibly.

2.3.	 Work at the electronics

Working in the area of installation and commis-
sioning of the electronics may only be allowed 
by qualified personnel. This means persons who 
due to education, experience and instruction, have 
sufficient knowledge of relevant directives and ap-
proved technical rules.

3.	 Important details

3.1.	 Intended usage

This operation manual is valid for module elec-
tronics PWDXXA-40X series. Any use diverging 
or going beyond is deemed to be as not intended. 
The manufacturer is not liable for warranty claims 
resulting from this.
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4.	 Mounting / Installation

4.1.	 Scope of supply

Please check immediately after receiving the elec-
tronics, if the content is matching with the specified 
scope of supply. The delivery includes:
•	 module electronics
•	 operation manual

	 Please check the delivery immediately after 
receiving the shipment for apparent damages 
due to shipping. Report shipment losses at 
once to the carrier, the insurance company 
and the supplier!

4.2.	 Mounting

•	 Compare electronics type (located on the name 
plate) with part list resp. circuit diagram.

•	 The module may be mounted in any direction.
•	 The module has to be mounted within a shielded 

environment (i.e. control cabinet).
•	 For mounting an assembly rail acc. EN 50022 

is required.

4.3.	 Operation limits

The electronics may be operated within the de-
termined limits only. Please refer to the “technical 
data” section.

	Follow the environmental conditions! Unal-
lowable temperatures, shock load, moisture 
exposure, radiation exposure, illegal electro-
magnetic emmissions may result in operating 
trouble and may lead to failure! Follow the 
operating limits listed in the “specifications” 
table!

4.4.	 Electrical connection

The electrical connection of the  module electron-
ics takes place by disconnectable screw terminal 
blocks.

	 This easy-to-install connection type allows a 
fast module replacement and a visible separa-
tion of the electrical connection. An additional 
folding unlocking lever allows simple removing 
of the terminal blocks and serves at once as 
shock hazard protection and marking strip.

Dimensions assembly rail

Work flow for module installation
Mounting:
1.	Apply the module with the assembly rail guide 

at the lower edge of the rail.

2.	Engage the module upward.

Removing:
1.	Lift the metal socket lock with a suitable screw-

driver (approx. 4 x 1 mm blade) against the 
spring force.

2.	Unmount the module at the top edge of the 
assembly rail.
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Skinning length for the connection wires

Wiring diagram of supply voltage

The connecting wires have to comply to the follow-
ing specification:		
Wire type:	 hookup cable, stranded
Cross sections:	 supply and solenoids min. 	
	 AWG 16/1.5mm²
	 sensor and signals min. 	
	 AWG 20/0.5mm²
Wire length:	 max. 50m

	 For wire lengths > 50 m consult factory.

The screw terminals are designed to allow termina-
tion of all kinds of copper wires without the need 
for preparation. Copper made wire end sleeves 
may usable as conductor stripping protection for 
the stranded wires.

	Soldering of the connection wires is not per-
mitted.

To ensure EMC-compatibility the wiring of the mod-
ule has partly to be undertaken by shielded cables. 
Detailed information can be read from the chapter 
“Electrical Interfacing”.

	The installation has to take place by quali-
fied personnel! A short between individual 
conductors, loose wires as well as improper 
shield connection may result in malfunction 
and breakdown of the electronics resp. the 
connected valve!

	The mounting surface of the valve has to be 
carefully tied to the earth grounded machine 
frame. The earth ground wire from terminal 
8 as well as the cable shields have to be tied 
to the protective earth terminal within the 
control unit. It is necessary to use a low ohmic 
potential connection between control unit and 
machine frame to prevent earth loops (cross 
section min. AWG 6 / 10mm²).

4.5.	 Electrical interfacing

Supply Voltage:
The supply voltage for the electronics will be con-
nected to the terminals 1 and 2 of the module 
electronics and has to cover the range of 18...30V. 
The residual ripple may not exceed 5% eff.

	The applied power supply must comply to 
the relevant regulations (DIN EN 61558) and 
must carry a CE-mark. The operating voltage 
for the electronics must be free of inductive 
surges. Do not exceed the max. value of 30V! 
Non-observance of this rule may result in 
permanent damaging of the electronics resp. 
the connected valve!

	The increased inrush current of the valve 
should be considered when selecting the 
power supply. A stabilized power supply with 
overcurrent limiting feature should not be used. 
Due to the inrush current of the electronics the 
current limit circuit may respond prematurely 
and create problems during energizing of the 
supply voltage.

	The operation of the electronics is blocked if 
the supply voltage polarity is interchanged.

	Each electronics requires a separate pre-fuse 
of 2.5 Amp time lag. Non-observance of this 
instruction may create irreparable damage of 
electronics resp. incorporated system parts.
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Wiring diagram of enable input

Enable input
A signal voltage applied to the terminals 3 and 
13 enables the solenoid output of the electronics. 
Continuous operation of the electronics requires a 
permanent voltage 5...30V (i.e. the supply voltage). 
In case of disabling the signal the solenoid output 
of the electronics will be switched off in no time 
independently from the command signal value. At 
the same time the position controller output will be 
clamped. In case of restarting the enable signal, the 
valve spool takes its position always out of the fail 
safe position. Preferable the enable signal should 
be switched on together with the hydraulic pressure 

supply. This forces the valve solenoid into drop out 
condition when the hydraulic system is switched 
off, and it avoids needless heating of the actuator.

	The enable function represents no safety 
arrangement against unwanted valve opera-
tion in terms of rules for accident prevention!

	 To block the valve function under all conditions, 
more advanced steps are necessary,  i.e. the 
installation of additional safety check valves.

Command signal input
The command signal to the valve will be connected 
to the terminals 5 and 6 of the difference signal 
input of the electronics. The connection has to be 
performed shielded.
The stroke of the valve spool behaves proportional 
to the command signal amplitude. Depending on 
the selected electronic parameters different ver-
sions of command signal processing are available, 
which are decribed below. 
For the function description terminal 6 is assumed 
as signal reference (0V).

	 Details are shown from the technical specifica-
tions. The parameter options for the command 
signal input are described in the chapter 
“Operating Instructions).

	The command input signal needs to be fil-
tered as well as free of inductive surges and 
modulations. To prevent malfunctions a high 
signal quality is recommended.

	 Incorrect signal amplitude levels may disturb 
the functionality and can damage the unit!
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Wiring diagram of voltage command input +10...0...-10V

Wiring diagram of voltage command input  +20...0...-20mA

Wiring diagram of current input  4...12...20mA

	 The option 4...20mA uses the “0mA” condition 
as breakdown-information. This means the 
presence of an evaluable failure information if 
the input signal line is interrupted. In this case 
the solenoid output will be switched off. The 
output will switched on when the input signal 
reaches a value of 3.8mA, it switches off when 

the command falls below 3.6mA. This deter-
mination follows the NAMUR-specification 
NE43. If necessary, the command signal cable 
break detection can be disabled by selecting 
the parameter E19.

	 NAMUR is an association of users of 
process control technology.
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If a comparator window for the feedback signal 
monitoring is defined via parameter P21, the output 
generates a voltage signal of 0V if the upper or 
lower threshold is detected. Within the window the 
output value is typ. 10V.

	 The monitor output is not calibrated and 
represents simply a trend indicator.

	The output may drive a load of max. 5mA. 
Exceeding this limit leads to malfunction.

Wiring diagram of monitor output

Wiring diagram of status output

Monitor output (optional comparator output)
A voltage information representing the feedback 
signal (i.e. the valve stroke) is available from the 
terminals 7 and 13. Herewith a voltage span of 
+10V...0...-10V means +100...0...-100% feedback 
signal range. The signal resolution of this output 
averages 8 bit = 0,4%. In case of a breakdown 
within the sensor cable the monitor output will be 
switched off, provided that the feedback signal 
cable break detection is in use (parameter E12).

Status output
The terminals 4 and 13 distributes a signal infor-
mation about the status of the electronics. The 
following information is available:
•	 feedback signal cable break 
	 (not for options voltage / ±20mA)
•	 command signal cable break 
	 (only for option 4...20mA)

•	 internal processor fault
•	 enable off

	The output may drive a load of max. 15mA. 
Exceeding this limit leads to malfunction.
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Wiring diagram of solenoid output

Solenoid outputs
The valve solenoids have to be connected to the 
terminals 9 and 10 as well as 11 and 12, while the 
earth ground connection of the solenoids is made 
via terminal 8. The connection has to be shielded.

	The solenoid connectors may not contain 
any protective or indication components, i.e. 
recovery diodes or lamps, otherwise function 
disturbances and permanent damages may 
occur to the electronics module.

Sensor input
The sensor has to be wired to the terminals 13 
and 16, the earth ground connection will be made 
via terminal 8. The connection has to be shielded. 
The sensor type is selectable via software param-
eter E11.

	 The module is usable for valves of design 
series D*FC, D*FS, RLL*R, WLL*R (standard 
connection). On appropriate selection of the 
parameter E11, sensors with other signal 
spans may be connected.

	Connection of an unusable sensor may lead to 
permanent damage to the electronics module.
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Wiring diagram of standard sensor input (Parker valves)

Wiring diagram of sensor input 0...±10V

Wiring diagram of sensor input 0...+20mA / 4...12...20mA, 3-wire

Wiring diagram of sensor input 0...+20mA / 4...12...20mA, 2-wire
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ProPxD screenshot

5.	 Operating instructions

Basically the electronics performs the task of 
converting a command signal into a proportional 
control value via the connected valve with the 
highest possible dynamic. For these purposes the 
input value will be electronically compared with 
the feedback of the process value (i.e. the spool 
position) within the module. The signal difference 
feeds a position controller, that in turn provides via 
a power amplifier stage the required current for the 
solenoids of the valve.

5.1.	 Operating software program

ProPxD parameterizing software:
The ProPxD software permits comfortable param-
eter setting for the module electronics. Via the 
clearly arranged entry mask the parameters can be 
noticed and modified. Storage of complete param-
eter sets to floppy or hard disk is possible as well 
as printout or record as a text file for further docu-
mentation. Stored parameter sets may be loaded 
anytime and transmitted to the module electronics 
in the same manner as the basic parameters which 
are available for all usable valve series. Inside the 
electronics a nonvolatile memory stores the data 
with the option for recalling or modification.

	The connected valve may not operated before 
loading an appropriate parameter set from the 
PC into the module electronics!

Features
•	 comfortable editing of all parameters
•	 depiction and documentation of parameter sets
•	 storage and loading of optimized parameter 

adjustments
•	 executable with all actual Windows® operating 

systems from Windows® 95 upwards
•	 plain communication between PC and electron-

ics via serial interface RS-232C and nullmodem 
cable

The ProPxD operating software may be ordered 
under code 5715543. Alternatively,  the program 
is ready for download from the Parker internet 
homepage address

	 http://www.parker.com/euro_hcd
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Connection diagram of the null modem cable

Hardware requirements
•	 PC with operating system from Windows® 95 

upwards
•	 interface RS-232 
•	 display resolution min. 800 x 600
•	 nullmodem connection cable between PC and 

electronics module
•	 storage requirement approx. 4 MB

	 It is recommended to select “small fonts” at 
the display setting, otherwise distortion of the 
display may occur.

Null modem cable
The connection of the module electronics to a PC 
requires a so-called “null modem cable”. Such a 
cable can normally be obtained from computer 
shops as well as from catalog distributors for elec-
tronic components. A proper function of the data 
communication requires in this case at least the 
following described cable configuration. The cable 
has to be inserted between an unused serial port 
COM1 or COM2 of the PC and the 9pole socket 
connector of the module.

Buying sources for the null modem cable

5.2.	 Program installation

Please check before installation if the above hard-
ware requirements are met. If your PC has already 
stored an older version of the “ProPxD” program, 
it has to be deinstalled by using the Windows®  
- system control feature.

Program installation sequence
•	 Terminate the execution of other programs.
•	 Insert ProPxD-software CD.
•	 Execute the file “setup.exe”.
•	 Follow the instructions on the screen.

Answer the question, if an older version should 
be overwritten, with “ok”. During the installation 
you may change destination drive resp. installation 
path, if needed (i.e. if the storage space on drive 
“c” is not sufficient).
Please answer also “ok” if at the end of the instal-
lation the program reports any system information. 
After successful installation the desktop display 
shows the ProPxD icon for starting the program.

Supplier Order-nr.
Viking G2E-71B10

Farnell 976880

DisData 672786

Staples IM1511680

Newark 83F7101

DigiKey AE1033-ND

CompUSA 50023590
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5.3.	 Software operating

	 Incorrect settings may lead to malfunction! 
In case of parameter changes shut the drive 
down!

Brief instruction for first startup
•	 Connect the module electronics to the supply 

voltage.
•	 Connect the module to a PC via null modem 

cable.
•	 Click on the ProPxD icon to start the operating 

program.
•	 After displaying the program resp. data base 

version a program window opens and the con-
nected electronics will be automatically identified 
(possibly a manual identification via the button 
“Receive all” is necessary).

•	 Select the desired version via the menu “Op-
tions/Optionen” with the menu item “Language/
Sprache”.

•	 Select the engaged valve from the provided 
type table via the menu “Options” and the item 
“Valve type”.

•	 Subsequently the program inserts the valve spe-
cific default parameters into the parameter table.

•	 Individual parameters may be selected via 
mouse or the arrow buttons at the center of the 
program screen.

•	 Parameter changes are possible via mouse or 
the arrow buttons on the bottom left within the 
program screen, also the parameter values may 
be edited via the keyboard.

•	 Modified parameters will be stored via the “Enter” 
key or via the button “Update list”.

•	 After completing of all modifications, the entire 
parameter set may be transmitted to the electron-
ics via the button “send all”, also the parameters 
will be nonvolatile stored.

•	 The chosen parameters may be optionally stored 
on the PC via the “File” menu with the menu item 
“Save as”, data retrieving is always possible via 
the function “Load out of database”

Extended functions
The user software is shared into 2 parameter 
ranges:
•	 basic mode
•	 expert mode

For normal startup the basic mode is absolutely 
sufficient. It permits the setting of all application 
specific parameters to match the valve function 
with the task setting, the valve specific parameters 
will be selected from the valve library. In case of 
special applications the valve parameters may be 
adapted via the expert mode.
The operating mode may be selected from the 
“Options” menu and remains after termination and 
re-start of the program.

	Changing of expert parameters is only permit-
ted for qualified personnel.

To prevent an unauthorized access for the ex-
pert mode, a password is requested. The name is 
“parker” and cannot be changed. Thus additionally 
to the button “Default” for loading of the default 
parameters, the button “Send parameter” appears 
in the “Expert”-operating mode. This button trans-
mits only the setting of one single parameter to the 
connected module electronics. Thus a quick tuning 
of single parameters is permitted during the setup.

	 A horizontal bar graph readout between 
the communication buttons shows the data 
transfer state.

Additional to the device parameters, the electron-
ics stores also the device types, selected from the 
valve library. Via the button “receive all” the valve 
parameters will be read out of the electronics and 
stored including the valve type. If expert param-
eters will be modified and transfered, the valve 
information memory inside the electronics will be 
erased and the word “customized” is shown within 
the valve display area. Via an arrow button located 
beside the view boxes of “Type”, “Design series” 
and “Valve”, the corresponding selection table may 
be reached directly.	
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Parameter overview for basic mode

	 Because the ProPxD program has also offline 
(i.e. without connection to the electronics) 
functionality, a manual pre-selection of the 
parameters is possible. After selection of the 
electronics type via the menu “Options” the 
parameters may be set and stored for later 
transmission. Note the design series while 
selection of the electronics!

The “File” menu provides the functions “Printer 
setup”, “Print preview” and “Print”. The print pre-
view includes the option for parameter set storage 
as text file (format  .txt) prior to further processing. 
The “Options” menu provides also the selection 
of the RS-232 interface port via the menu item 
“Port”. Via the menu item “Load out of database” 
previously stored parameter sets may be loaded.

Parameter Description Unit
Parameter range

Default setting
from up to

S5
S6
S7
S6

ramp accel. channel A
ramp decel. channel A
ramp accel. channel B
ramp decel. channel B

ms
ms
ms
ms

0
0
0
0

32500
32500
32500
32500

0
0
0
0

P1
P3
P4
P7
P8
P11
P12

zero
MAX channel A
MAX channel B
MIN channel A
MIN channel B

polarity command
polarity feedback

%
%
%
%
%
–
–

-100.0
50.0
50.0
0.0
0.0
0
0

+100.0
100.0
100.0
50.0
50.0

1
1

0.0
100.0
100.0
0.0
0.0
0
0

E17 option command –
1 = ±10V

2 = ±20mA
3 = 4 ... 20mA

1 = ±10V

E19
cable break detection

command
– 0

±10V: 0
±20mA: 0

4 ... 20mA: 1
0

	 Information on the technology functions is 
provided within the help function of the operat-
ing software.

5.4.	 Adjustment parameters

The available parameters may be divided into mul-
tiple groups and are characterized by different 
letters:		
S-parameters	 internal commands and ramps
P-parameters	 operating parameters
E-parameters	 extended parameters
I-parameters	 solenoid current parameters
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S5
ramp accel. channel A

Adjustment of ramp rate for increasing of valve side A.
To avoid switching noise.

S6
ramp decel. channel A

Adjustment of ramp rate for decreasing of valve side A.
To avoid switching noise.

S7
ramp accel. channel B

Adjustment of ramp rate for decreasing of valve side B.
To avoid switching noise.

S8
ramp decel. channel B

Adjustment of ramp rate for decreasing of valve side B.
To avoid switching noise.

P1
offset

Adjustment of zero position shifting (offset).
To compensate for unbalances within the zero position of the valve.

P3
MAX  channel A

Adjustment of maximum stroke for valve side A at 100% command signal.
To match the command signal span to the valve operating range.

P4
MAX  channel B

Adjustment of maximum stroke for valve side B at 100% command signal.
To match the command signal span to the valve operating range.

P7
MIN  channel A

Adjustment of stroke step for valve side A at 0,1% command signal.
To compensate for the overlap of the valve spool. 

P8
MIN  channel B

Adjustment of stroke step for valve side B at 0,1% command signal.
To compensate for the overlap of the valve spool. 

P11
command signal polarity

Adjustment of the command signal polarity.
To match the command signal polarity to the valve operating direction.

P12
feedback signal polarity

Adjustment of the feedback signal polarity.
To match the sensor signal polarity to the solenoid polarity of the valve.

E17
type of com. sig. device

Adjustment of the command signal option.
To match the command signal input to the input signal mode.

E19
cable break detection
command

Adjustment of the operating mode for the command cable break detection. 
To turn on resp. off the cable break detection for the command signal at a 
selected command signal option of 4...20mA.

Individual description of basic parameters
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Parameter overview for expert mode

Parameter Description Unit
Parameter range Default set-

tingfrom up to
P5 dither amplitude % 0 10.0 0
P6 dither frequncy Hz 0 300 0
P9 quiescent current channel A % 0 25.0 0
P10 quiescent current channel B % 0 25.0 0
P13 bypass gain – 0 100.0 0
P14 T-portion PT1-element – 0 100.0 0
P16 P-portion – 0 100.0 0
P17 I-portion – 0 100.0 0
P18 D-portion – -100.0 +100.0 0
P19 T-portion DT1-element – 0 100.0 0
P20 feedback scaling % 0 200.0 100.0
P21 comparator function window % 0 200.0 0
P23 comparator rise delay time ms 0 10000 0
P24 comparator turn-off delay time ms 0 10000 0
P26 window I-portion – 0 20 20
P27 reduct. window I-portion – 0100.0 100.0 100.0

E2 closed loop control –
0 = inactive (open loop)

0 = inaktiv1 = active (int. closed loop)
2 = active (ext. closed loop)

E11 position transducer type –

1 =  ±10V

1 =  ±10V

2 = ±20mA
3 = 4-20mA bipolar

4 = D1FC/WLL NG06
5 = D3FC/WLL NG10

6 = RLL NG06
7 = D31FS
8 = D41FS
9 = D81FS
10 = D91FS
11 = D111FS

12 = 4-20mA unipolar
13 = TEL 50/70
14 = TEL 90/125

E12
cable break detection 

feedback
– 0

voltage: 0
0 =  voltagecurrent ±20mA: 0

current 4-20mA: 1

E25 MIN operating threshold –
0 = 1%

0 = 1%
1 = 0.01%

IA solenoid current channel A –
1 = 3.5A

2 =  2.7A2 = 2.7A
4 = 1.3A

IB solenoid current channel B –
1 = 3.5A

2 =  2.7A2 = 2.7A
4 = 1.3A
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Individual description of expert parameters

P5
dither amplitude

Adjustment of dither amplitude.
To reduce the influence of solenoid friction.

P6
dither frequency

Adjustment of dither frequency.
To match the dither signal to the valve dynamic.

P9
initial current channel A

Adjustment of the bias current for the solenoid of the valve side A.
To compensate for the solenoid initial current.

P10
initial current channel B

Adjustment of the bias current for the solenoid of the valve side B.
To compensate for the solenoid initial current.

P13
bypass gain

Adjustment of the bypass gain for the controller.
To improve the control dynamic.

P14
T-portion of PT1

Adjustment of the integral action time for the PT1-portion of the controller.
To attenuate for the P-portion.

P16
P-portion

Adjustment of the P-portion for the controller.
For the basic tuning of the controller.

P17
I-portion

Adjustment of the I-portion for the controller.
To reduce the control failure.

P18
D-portion

Adjustment of the D-portion for the controller.
To improve the control dynamic.

P19
T-portion of DT1

Adjustment of the pre-hold time for the DT1-portion of the controller.
To attenuate for the D-portion.

P20
feedback scaling

Adjustment of the scaling factor for the feedback signal.
To match the feedback signal span to the operating range.

P21
window for comparator 

function

Adjustment of the comparator window for the feedback monitoring.
To adjust the feedback monitoring range.

P23
comparator rise delay 

time

Adjustment of the comparator rise delay time.
To delay the rise threshold for the comparator function.

P24
comparator turn-off 

delay time

Adjustment of the comparator turn-off delay time.
To delay the turn-off threshold for the comparator function.

P26
window for I-gain 

activation

Adjustment of the I-portion active range in terms of the control difference.
To limit the I-portion on a certain range.

P27
I-gain window reduction

Adjustment of the I-portion outside the window in terms of the control diffe-
rence.
To match the response behaviour to the I-portion.

E2
control mode

Adjustment of the operating mode for the controller.
To select the control function.

E11
type of feedback device

Adjustment of the feedback device type.
To match the feedback input to the signal device features.

E12
cable break detection 

feedback

Adjustment of the operating mode for the feedback cable break detection.
To turn on resp. off of the cable break detection for the feedback signal.

E25
MIN operating threshold

Adjustment of the MIN operating threshold.
To match the response sensitivity for the MIN-stroke step.

IA
nominal current 

solenoid A

Adjustment of the maximum current for the solenoid of the valve side A.
To match the solenoid output to the nominal current of the solenoid.

IB
nominal current 

solenoid B

Adjustment of the maximum current for the solenoid of the valve side B.
To match the solenoid output to the nominal current of the solenoid.
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5.5.	 Error messages

Malfunctions when using the ProPxD software program will be indicated via appropriate failure mes-
sages.

Failure message Description / corrective action

The Com Port is not available!
Terminate the other program, or quit the message and select another 
RS-232 port via the menu “Options > Port”. Afterwards reconnect 
the null modem cable.

Unable to open COM port
Com port is not available. Quit the message and select another 
RS-232 port via the menu “Options > Port”. Afterwards reconnect 
the null modem cable.

There is no module connected or 
the communication is disturbed!

No data exchange possible. Either the electronics has been removed, 
the port is mismatched, or the connection will be disturbed by strong 
electrical fields. Check if the Com port is set for “9600, 8, 1. none, 
none” via the menu “Options > Port”.

Wrong password! Retype the password, notice the exact spelling (case sensitivity).

Wrong input!
An unvalid character or a value outside the permitted range has 
been used at parameter entry.

Keep the entered parameters?
During parameter loading from the electronics module memory 
the preset parameters from the left hand screen display may be 
rejected or maintained.

The chosen module isn´t the 
same as the connected hardware!

In principle, parameters dedicated to a type which deviates from 
the connected electronics module may be edited. However, for data 
transmitting the correct module has to be connected. If parameters 
will be loaded from a module which deviates from the selected 
one, the parameters from the left hand side screen display of the 
program will be overwritten.

file name.pxd already exists. Do 
you want to replace the file?

The file name already exists within the indicated directory. Select 
another name, another directory or overwrite the existing file with “OK”.

Failure messages and corrective actions
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Location of status indicator

Operating condition LED-display
no failure green

no supply voltage off

no enable signal yellow

cable break feedback sensor (not for options voltage / +-20 mA) red

cable break command signal (only for option 4...20 mA) red

internal processor fault red

Function assignment

status indicator

6.	 Maintenance

Periodical maintenance is essential for the lon-
gevity of the unit and guarantees reliability and 
availability. 
The following properties of the electronics have 
to be checked in continuous short time intervals:
•	 tight fit on the mounting rail
•	 tight fit of the disconnectable terminals
•	 tight fit of the terminal screws
•	 environmental temperature level
•	 supply voltage level
•	 cleanliness of the ambience

	Service work may only be carried out by 
qualified personnel. Detailed knowledge of 
the machine functions concerning switching 
on and off as well as of the required safety 
relevant technical tasks is necessary!

7.	 Trouble-shooting

Basis of trouble-shooting is always a systematic 
approach. At first the following questions have to 
be checked:
•	 Are there practical experiences with similar 

failures?
•	 Have system adjustments been changed?

	 In either case the available diagnostic options 
should be used. The electronics permits a 
diagnostic of the valve function via the monitor 
output. The status output monitors the work-
ing condition of the electronics, an additional 
visual status results from an LED indicator.
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Afterwards starting of trouble-shooting by means of 
a priority list of the most likely reasons.
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8.	 Repair / Service

When you buy a Parker component, full technical 
support from Parker After Sales Service.
Our highly qualified team will be glad to assist you 
in all industrial and mobile applications.
•	 We offer full service:
•	 general support for starting up Parker hydraulic 

controls
•	 maintenance of Parker controls
•	 repair of all Parker related hydraulic and electri-

cal devices
•	 assistance in the supply of spare parts worldwide
•	 direct service for mobile applications at our 

Service Center in Kaarst, Germany
•	 direct replacement for parts subject to wear at 

our Service Center in Kaarst, Germany
•	 technical training in theory and practice

For further questions please contact us:

Parker Hannifin GmbH		
Hydraulic Controls Division		
After Sales Service			 
Gutenbergstr. 38			 
D-41564 Kaarst			 
Phone:	 (+49)181-9944-430




